Build Number
Documentation Resources
New Features and EnhancementsChapter 2. Requirements
Software Requirements
Hardware Requirements
Network Requirements
Third-party RequirementsChapter 3. Limitations and Restrictions
Limitations and Restrictions
Performance and Behavior NotesChapter 4. Caveats
Bug Severity Levels
Search for Bugs
Open Caveats
Resolved Caveats
These release notes describe new features, requirements, restrictions, and caveats for all versions of Cisco Jabber for Windows Release 10.6.x. These release notes are updated for every maintenance release but not for patches or hot fixes. Note that each maintenance release includes the features, requirements, restrictions, and bug fixes of the previous releases unless mentioned otherwise. Before you install Cisco Jabber for Windows, we recommend that you review this document for information about issues that may affect your system.
The build number for this release is 10.5.37889.
The following documents are available for Cisco Jabber for Windows.
Release Notes
Provide administrators with a summary of information about the release, which include feature enhancements, requirements, limitations and restrictions of the software, and caveats overview.
Deployment and Installation Guide
Provides administrators with information for all Jabber clients in one guide. It contains end-to-end client deployment procedures, comprising requirements, deployment scenarios and workflows, infrastructure configuration of services, and client configuration and installation.Licensing Information
This Licensing Information document provides information on the open source libraries used by the application.
Quick Start Guide
Instructions to help navigate end users around Cisco Jabber for Windows for the first time and use a few key features.
Advanced Features Guide
Provides an overview of task-based information about end user operation of the client.
Accessibility Guide
Provides information on navigating the client, including shortcut keys, keyboard navigation, and other accessibility features.
Single Sign On
Security Assertion Markup Language (SAML) is an XML-based open standard data format that enables you to access a defined set of Cisco services seamlessly after verifying credentials with an Identity Provider. You enable SAML SSO in Cisco WebEx Messenger Services, Cisco Unified Communications Manager, or Cisco Unity Connection. It is deployed in the Jabber client using service discovery.
For more information about SAML SSO, see the chapter on Single Sign-On (SSO) Deployments in the Cisco Jabber Deployment and Installation Guide.
Reset Jabber
Resetting Jabber gives users the ability to reset Jabber to the originally-installed state.
Telemetrics
In this release, the client is enabled to help improve your Cisco Jabber experience by sending anonymous data to Cisco on elements such as call analytics and call quality.
Personal Ringtone
Users can select a ringtone for incoming calls from a menu of distinctive ringtones for their client in the Options menu, under Sounds and Alerts.
Hunt Groups
Hunt Groups enable incoming calls to be directed to a group of users. The call route is based on a number of factors, including first available , longest Idle, broadcast hunting and circular hunting. You can use Cisco Jabber and deskphones to answer hunt group calls.
A hunt group works in conjunction with route filters and hunt lists to direct calls to specific devices. If a phone or device is ringing and not being answered, then another available number is searched for until the call is answered.
A hunt list contains a set of line groups in a specific order. A single line group can appear in multiple hunt lists. A line group comprises a group of directory numbers in a specific order. The order controls the progress of the search for available directory numbers for incoming calls.
Call Pickup
Call Pickup allows users to pick up incoming calls from their own group. Group Call Pickup and Directed Call Pickup allows users to pick up incoming calls to another group or individual, respectively. You can use Cisco Jabber and deskphones to answer call pickup calls.
Directory numbers are assigned to call pickup groups and Cisco Unified Communications Manager automatically dials the appropriate call pickup group number. Users select Pickup to answer the call.
Call pickup: Allows users to pick up incoming calls from their own group.
Group call pickup: Allows users to pick up incoming calls from another group.
Other group pickup: Allows users to pick up incoming calls from a group that is associated with their group. You cannot use this option with the hunt group feature.
Directed call pickup: Allows users to pick up an incoming call on a directory number. You cannot use this option with the hunt group feature.
Video Call Quality
Improvements in video image edge interpolation deliver smoother and sharper video calling for users in call scenarios.
Using the available graphics processing hardware, if it is available on the client machines, also reduces the CPU load for Cisco Jabber video calling and ensures faster bandwidth adaptation.
Audio Call Quality
The G.722 wideband audio codec is now introduced as the default codec for calls to Cisco IP deskphones and other portfolio endpoints, which delivers a superior call experience to the user. You can provision other audio codec selection preferences in Cisco Unified Communications Manager, if required.
Plantronics Call Control
In addition to Jabra and Logitech headsets, users can now use Plantronics accessories to control their calls on Cisco Jabber to adjust call volume, answer and end phone calls, and mute.
Self-view
Users can move and resize the self-view window on video calls.
IM Only Screen Sharing
In addition to the video screen share (BFCP) feature that is available to video-enabled clients when on a call, users can now screen share directly from an IM conversation when video share is not provisioned or available. IM screen sharing uses Microsoft RDP, which is a secure connection. When using IM only screen sharing, the screen share resolution and bandwidth allocations are directly managed by the underlying Windows OS.
Users can share their screens from IM with up to five other Cisco Jabber for Windows 10.5 users in a group chat.
Unlike BFCP, users do not need to be in a call to share their screen. Screen sharing is not currently supported while on the Expressway for Mobile and Remote Access.
Remote Desktop Control
When screen sharing from an IM, a user can request permission to remotely control the desktop of the user who is sharing the screen. Either user can revoke the remote desktop control at anytime. Remote desktop control is not currently supported while on the Expressway for Mobile and Remote Access.
IM Notifications
This release offers new incoming chat message alerts, new chat alert sound and IM badges in the Windows taskbar. In addition to your Cisco Jabber client icon flashing on your Windows taskbar, users also receive notifications that pop up on their screens when they have a new message. IM notifications are displayed for chats, group chats, and in persistent chat rooms.
IM Do Not Disturb
The client now offers Do Not Disturb in the client to suppress IM notifications. Only notifications are suppressed and not the messages. Users can configure whether they receive the notifications from the Options menu.
Spellcheck (Windows 8)
Spellcheck is available for instant messaging chats on Cisco Jabber clients running on Windows 8 operating system. Language support is dependent on those supported by Windows 8. Spellcheck is active only for the language defined for your operating system, not the language defined for your Jabber client.
New Emoticons
The selection of emoticons has been increased for users in their chat conversations. The existing emoticons have also been redesigned for improved user experience.
Persistent Chat Rooms are applicable to on-premises deployments only.
Persistent Chat Room Administration and Moderation
Administrators can now create and delete rooms, manage membership, and moderate rooms. You can define up to 30 room moderators who can create or remove rooms, add or remove members, and define room types and descriptions.
Persistent Chat Room Message Search
Users can search for messages in their chat room histories.
Persistent Chat Room Notifications
Users get notifications for new chat room messages and filter matches.
Conversation Window Control in Deskphone Control Mode
The user can control whether the conversation window comes into focus for different types of call when in deskphone control mode.
Users can now configure when to bring their conversation window to the front when in deskphone control mode (CTI mode). When users pick up their phone, a conversation window is displayed on the user's screen. Users can configure the conversation window to open for all calls, video calls only, or never. Users configure this window behavior in the Options menu. The default behavior is to have the conversation window come into focus for calls, as it was in previous releases.
Option | Result |
OnCall | Conversation window is displayed automatically when the deskphone is picked up or there is an incoming call. |
OnVideo | Conversation window is displayed only when there is an incoming video call. |
Never | Conversation window is not displayed for a call. Instead, it is automatically minimized in the Windows task bar with the Cisco Jabber icon. |
Call Statistics
You can now view real-time statistics when on a call. Use Ctrl + Shift + S to open call statistics. You can view audio, video, and screen share statistics, and copy the statistics into the clipboard to send to others.
IM Protocol Handler Enhancement
You can now configure the IM protocol handlers that are supported by Cisco Jabber for Windows to pre-populate the conversation window with a subject line and body text when users click on the link text for both peer-to-peer and group messages.
New: Cisco Jabber Deployment and Installation Guide
This new guide comprises deployment, configuration, and installation information for all Jabber clients: Cisco Jabber for Windows, Cisco Jabber for Mac, Cisco Jabber for iPhone and iPad, and Cisco Jabber for Android. It contains procedures in one guide that were previously published in the Installation and Configuration Guide, Server Setup Guide, and DNS Configuration Guide.Cisco Jabber for Windows 10.5 or later
Cisco Jabber for Windows 9.7.4 or later
Cisco Jabber for Windows 9.6.3 or later
For more information, read the Security Update to Cisco WebEx Customers at Click Here .
To receive further details on the dates of the required Cisco WebEx Meeting Center upgrade, contact us at the following email address and include your WebEx Meetings domain(s):
Microsoft Office 2007
Microsoft SharePoint 2007
Active Directory Windows Server 2003
Cisco Medianet MSI 4.1.2 for deskphone video.
2 GB RAM on Microsoft Windows 7 and Windows 8
128 MB
256 MB
DirectX11 on Microsoft Windows 7
USB 2.0 for USB camera and audio devices.
Port | Protocol | Description |
---|---|---|
443 | TCP (Extensible Messaging and Presence Protocol [XMPP] and HTTPS) | XMPP traffic to the WebEx Messenger service. The client sends XMPP through this port in cloud-based deployments only. If port 443 is blocked, the client falls back to port 5222. Note: Cisco Jabber can also use this port for:
|
30000 to 39999 | FECC | The client uses this port for far end camera control. |
389 | UDP/TCP | Lightweight Directory Access Protocol (LDAP) directory server. |
636 | LDAPS | LDAP directory server (secure). |
2748 | TCP | Computer Telephony Interface (CTI) used for desk phone control. |
3268 | TCP | Global Catalog server. |
3269 | LDAPS | Global Catalog server (secure). |
5222 | TCP (XMPP) | XMPP traffic to Cisco Unified Presence or Cisco Unified Communications Manager IM and Presence Service. |
8443 | TCP ( HTTPS ) | Traffic to Cisco Unified Communications Manager and Cisco Unified Communications Manager IM and Presence Service. |
7080 | TCP ( HTTPS ) | Cisco Unity Connection for notifications of voice messages (new message, message update, and message deletion). |
53 | UDP/TCP | Domain Name System (DNS) traffic. |
80 | HTTP | Saving chats to Microsoft Exchange server. Depending on your server configuration on Microsoft Exchange, use either port 80 or 443, but not both. |
37200 | SOCKS5 Bytestreams | Peer-to-peer file transfers. In on-premises deployments, the client also uses this port to send screen captures. |
5060 | UDP/TCP | Session Initiation Protocol (SIP) call signaling. |
5061 | TCP | Secure SIP call signaling. |
49152 to 65535 | TCP | IM-only screen share. The client randomly selects a port from the range. The actual range may vary. To find the real range, enter the netsh interface ipv4 show dynamicportrange tcp command. You can use the SharePortRangeStart and SharePortRangeSize parameters to narrow the range used for IM screen share. For more information on these parameters, see the section on Common Policies parameters in the Deployment and Installation Guide. |
![]() Note | Microsoft Exchange integrates directly with Cisco Unified Communications Manager. For more information, see the Configuration Guides for the appropriate version of Cisco Unified Communications Manager. |
Microsoft Office 2013
Microsoft Office 2010
Microsoft SharePoint 2010
If you deploy antivirus software, include the following folder locations in the antivirus exclusion list:
C:\Users\<User>\AppData\Local\Cisco\Unified Communications\Jabber
C:\Users\<User>\AppData\Roaming\Cisco\Unified Communications\Jabber
C:\ProgramData\Cisco Systems\Cisco Jabber
Authenticated Proxies
Hosted photos cannot be displayed in Cisco Jabber for Windows due to an issue supporting authenticated proxies, even if the server is listed in the Bypass setting. For more information on this item, see CSCul02706.
Blank Screen Share over VXME
Connecting to your client in virtual environment
Using VXME for softphone calls
On a video call
Sharing your screen
Cached Contacts in Microsoft Exchange
Microsoft Exchange 2013 has changed the way it handles cached contacts. This change may result in some cached contacts being stored in hidden folders in Microsoft Outlook that are not viewable or customizable by the end user.
As a result, the Cisco Jabber client may return duplicate and incorrect contacts when searching Microsoft Outlook. If the incorrect contacts are stored as a contact in a user's client, it may lead to other side-effects such as incorrect presence in both the client and Microsoft Outlook. This item is documented in CSCup78097.
Call History Limit
The client can store up to 250 entries in your call history. This item is documented in CSCun44797.
Call Pickup
If the options for Calling Party Information and Called Party Information are disabled in Cisco Unified Communications Manager, then users logged into Call Pickup in softphone mode do not see either calling party or called party information displayed in the call alert notification. However, if those options are disabled and users log into Call Pickup in deskphone mode, then calling party or called party information is still displayed in the alert.
If you select the Audio only notification on Cisco Unified Communications Manager and the user is on a call, then the user does not hear any sound indicating that there is a call to pick up.
If users select Pickup on their deskphone when in Deskphone Mode, a conversation window is displayed momentarily.
The pickup notification alert only displays a maximum of 23 characters.
The person receiving a call also receives a call pickup notification when they are URI dialed. This issue is documented in CSCuo75418.
Check Point VPN
Cisco Jabber for Windows does not currently support Check Point VPN.
Cisco Medianet Metadata Support
As of this release, Cisco Medianet Metadata is no longer supported.
Cisco Unity Connection Dispatch Messages
In Cisco Unity Connection, a dispatch message is sent to a distribution list with the message configured in such a way that only one user responds to that message. A user can accept, decline, or postpone the dispatch message. Cisco Jabber for Windows does not support Cisco Unity Connection dispatch messages.
Declining Calls in Hunt Group
If you enable the Legacy Immediate Divert option in Cisco Unified Communications Manager, users cannot decline calls when they are logged into Hunt Group in softphone mode, but can decline calls in deskphone mode. To disable users to decline Hunt Group calls in both softphone and deskphone mode, you must enable the parameter preventdeclineonhuntcall in the configuration file.
Descriptions for Multiple Devices
You must enter descriptions for each device if Cisco Jabber for Windows users have multiple deskphone devices of the same model. Cisco Jabber for Windows displays these descriptions to users so that they can distinguish between multiple deskphone devices. If you do not enter descriptions, the client displays the model name of the device and users cannot distinguish between various devices of the same model.
Diverting Calls in Do Not Disturb State
Setting your status to "Do Not Disturb" in the client does not divert or block incoming calls.
Emails to a Group of Contacts
There is a limit of 2083 characters in the To field when sending an email to a group of contacts. Depending on the length of the email addresses and the number of contacts, not all contacts may be added to the email. For more information about the 2083 character limitation, see Click Here . This limitation is documented in CSCuz80198.
Expressway for Mobile and Remote Access Unsupported Features
Extension Mobility Cross Cluster
Cisco Jabber for Windows does not currently support extension mobility cross cluster (EMCC).
Microsoft Outlook Local Contacts and Presence
Users' presence is unknown when the contact is manually added to contacts in Microsoft Outlook 2010 and 2013, when the contact is added to local (custom) contacts with an email address type of SMTP. To resolve this issue, delete the contact and add it again manually, ensuring the email address type is Exchange (EX). This item is documented in CSCuo57172.
Multiple Resource Login
Availability states change to 'Available' on all clients when users resume from hibernate on one client.
Resuming from idle overrides custom availability states.
Users who are signed in to multiple Cisco Jabber for Windows clients can join group chats from only one client.
Cisco Jabber for Windows does not always reformat incoming text correctly when the sender is signed in to a client other than Cisco Jabber for Windows.
Plantronics Accessories and Software
If you use Plantronics accessories for Cisco Jabber call management, and if you have Plantronics Hub installed, ensure that at least version 3.5 is installed. Download Plantronics Hub 3.5 from the Plantronics website.
SAML Single Sign-On Limitations
In this release, deploying SAML single sign-on is not supported if Expressway for Mobile and Remote Access is also deployed. If the Jabber client detects that Expressway for Mobile and Remote Access is deployed, it will never detect SAML SSO, even if you are not using it at the time.
When configuring SAML SSO on Cisco Unified Communications Manager and Unity Connection servers, you must use a fully qualified domain name (FQDN) instead of an IP Address to define the server name. If you use an IP Address, the client displays a warning message that the certificate is not valid. The requirement to use an FQDN is because the embedded Internet Explorer browser is not able to validate IP addresses in the Subject Alternate Name (SAN) certificate.
Space Characters in Credentials
The following rules apply to space characters and credentials:
Software Phone Not Supported in Virtual Environments (VDI mode)
Software phones (CSF devices) are not supported in virtual environments. Use Cisco Virtualization Experience Media Engine (VXME) for Cisco Jabber for Windows call capabilities in a virtual environment.
Special German Characters in Usernames or Passwords
The Cisco Jabber for Windows softphone fails to register with Cisco Unified Communications Manager when users enter some German special characters such as ü, ä, or ö in the username or password. The user receives the following error message: “Invalid username or password entered. Go to Phone Services in the Options window and enter the correct username and password". To resolve the issue, upgrade to Cisco Unified Communications Manager 9.1(2) or users should use lower ASCII characters for their username and passwords.
Standard CTI Secure Connection User Group
Cisco Jabber for Windows does not currently support CTI connections over transport layer security (TLS). As a result, Cisco Jabber for Windows users cannot switch from using a CSF device to using a desk phone device if they belong to the Standard CTI Secure Connection user group.
Third-Party Unified Communications Applications
Installing Cisco Jabber for Windows and third-party unified communications applications on the same machine may result in unexpected behavior in the client and is not recommended.
Using Click-To-X feature with Contacts in Microsoft Outlook
If you are using UDS as a directory source, users can only use Click-To-X capabilities, such as Click-To-Call and Click-To-IM, to contact Microsoft Outlook users if they are already in the cache file. A cache file is created for someone if they are in the users' Cisco Jabber contacts list, or have a Cisco Jabber history created by the user previously searching, IMing, or calling them, or by leaving a voice message. This item is documented in CSCuo88534.
Using Hunt Group on Desk Phones
If users select Use my phone for calls in their client to enable deskphone mode, then they must log in or logout of their hunt groups using the deskphone. If users are in deskphone mode, then the Log Into Hunt Groups option in the Cisco Jabber client becomes disabled.
Video Resolution of Lifesize Endpoint after Hold/Resume
Users may experience resolution issues when using Jabber to make a call with a Lifesize Express 220 endpoint. If the user puts the call on hold, then after resuming the call the send and receive video resolutions on the Jabber end is greatly reduced. For more information, see CSCur02498.
Voice Messages
The client cannot play broadcast voice messages.
Contacting Federated Users After Changing Privacy Policies
Users add federated contact to their contact lists.
Users change the policy for contacts outside the domain from Prompt me every time to Block everyone on the Privacy tab of the Options window.
As a result, the federated contacts remain in the contact list but do not display availability. Likewise, users cannot send or receive instant messages from those federated contacts.
As a result, Cisco Unified Presence removed the federated contacts from the contact lists. Cisco Unified Presence does not repopulate the federated contacts.
Because Cisco Unified Presence removed the federated contacts from the contact lists, users must add the federated contacts to their contact lists again to send instant messages or display availability status to those federated contacts. However, the federated contacts can send instant messages to the users, even if they are not in the contact list.
Disabling File Transfers and Screen Captures
You can disable file transfers and screen captures on Cisco Unified Communications IM and Presence with the Enable file transfer parameter.
Screen_Capture_Enabled
File_Transfer_Enabled
Expressway for Mobile and Remote Access Unsupported Features
Multiple Resource Login
Signing in on one client changes custom availability states to 'Available' on other clients.
If you set the availability state from 'On a call' to another state while on a call, the availability state does not automatically change to 'On a call' for subsequent calls.
Server Presence Issue in Client
If you are using Cisco Unified Presence 8.6.5 SU2 or earlier, or Cisco Unified Communications Manager IM and Presence 9.1.1 SU1 or earlier, the client might display users' presence as offline when the user is actually online and has a network connection. This presence issue is fixed in Cisco Unified Presence 8.6.5 SU3 and Cisco Unified Communications Manager IM and Presence 9.1.1 SU1 and 10.0.1. This item is documented in CSCui29999.
Space Characters in Credentials
The following rules apply to space characters and credentials in on-premises deployment scenarios:
Blocking Users in Enterprise Groups
Blocking users does not prevent a blocked user's status from being displayed if the blocked users are in a contact list as part of an enterprise group. For example, User A blocks User B. However, User A is in User B's contact list as part of an enterprise group. As a result, User B can view User A's availability status.
Photo Display
In late 2011, the WebEx server made changes to how photos are stored and formatted on the server. Due to this change, any photo uploaded before January 1, 2012 is not displayed in the client. To resolve the issue, users must re-upload the photo. For more information on this item, see CSCui05676.
Space Characters in Credentials
The following rules apply to space characters and credentials in cloud-only deployment scenarios:
When the client receives an incoming call, an incorrect contact name can display. This can occur when you have a contact in Microsoft Outlook that has the same phone number as a contact in your company directory.
Two meeting reminders are displayed for a meeting. One reminder displays the Time to join message. The other reminder includes a Meeting details link. Both reminders are sent automatically by the meeting host at the meeting start time. This behavior is documented in CSCuz06684.
Users can only remove participants from a conference call when using the softphone(CSF) device for calls. Users can't remove participants from conference calls in desk phone control mode or using extend and connect.
The settings to define the behavior of conversation windows are sometimes bypassed during conference calls. For example, a user configures the behavior of conversation windows to never come to the front. Then, during a conference call, the conversation window is brought to the front to add users to the conference call.
There are some situations where the conversation window does not behave as expected to benefit the user experience. These items are documented in CSCuo83446, CSCuo83415, CSCuo83452, CSCuo83387.
When users first sign-in using SAML SSO, they may be prompted to enter their user credentials outside of the Identity Provider (IdP). On subsequent logins, they are prompted by the IDP for credentials. This is because the user's email address is required to confirm whether they are enabled for SSO, and when the user supplies credentials, they are used to the email address associated with their username to confirm this information to determine whether the user is enabled for SSO.
To avoid initially prompting the user twice for their credentials upon initial sign-in to SAML SSO, you can set a parameter that requires the user to sign in using their email address, which immediately confirms their status as being SSO-enabled and does not prompt them a second time to provide credentials.
ServicesDomainSsoEmailPrompt
ON
OFF (default)
For more information on this parameter, see the parameters description in the Cisco Jabber Deployment and Installation Guide.
Users are homed on 10.5 SAML SSO-enabled cluster using 9.1 or 10.1 Central UDS
Users sign in with clean cache and reset Jabber
If you are upgrading to this release, and your client is enabled for IM-only mode, then you must set the Telephony_Enabled parameter to false. If you do not set this parameter in IM-only mode deployments, then users may see disabled telephony capabilities on their user interface.
In localized versions of the client, the icons on the hub window contain descriptive text, such as Contacts, Recents, Voice Messages, and Meetings. When this text is localized into other languages, if the translation of the text for even one icon is too long to be displayed on the user interface, then no text is displayed for any of the icons.
For on-premise deployments, if Cisco Unified Communications Manager IM and Presence Service is upgraded from release 9.1(1) to release 10.5(2) and clients appear in phone-only mode after the upgrade, then all clients must be reset.
When a user's first name or last name is changed either in LDAP or UDS directories, Cisco Jabber does not automatically update this information in the contact list for all watchers of this user. Users must manually update their contact lists using the following procedure:
Remove the contact from their contact list.
Sign out of Cisco Jabber.
Reset Cisco Jabber.
Click the gear icon and select File > Reset Cisco Jabber.
Sign in to Cisco Jabber again.
Add the contact again.
Severity Level | Description | |
---|---|---|
1 | Catastrophic | Reasonably common circumstances cause the entire system to fail, or a major subsystem to stop working, or other devices on the network to be disrupted. No workarounds exist. |
2 | Severe | Important functions are unusable and workarounds do not exist. Other functions and the rest of the network is operating normally. |
3 | Moderate | Failures occur in unusual circumstances, or minor features do not work at all, or other failures occur but low-impact workarounds exist. This is the highest level for documentation bugs. |
4 | Minor | Failures occur under very unusual circumstances, but operation essentially recovers without intervention. Users do not need to install any workarounds and performance impact is tolerable. |
5 | Cosmetic | Defects do not cause any detrimental effect on system functionality. |
6 | Enhancement | Requests for new functionality or feature improvements. |
To search for bugs, do the following:
Step 1 | Go to Click Here . |
Step 2 | Sign in with your Cisco.com user ID and password. |
Step 3 | Enter the bug ID or specify search parameters. |
For more information, select Help on the Bug Search page.
Identifier | Severity | Headline |
---|---|---|
CSCuq34958 | 2 | CTI Manager Service crashes when user ID exceeds 10 characters. |
CSCuo58251 | 2 | UDS returning IP Address to Jabber, Cert validation browser pop-ups. |
CSCup56878 | 3 | HTML Tab: Unexpected behavior when calling CTooltip::Show(). |
CSCup82846 | 3 | Wrong user may be selected on Jabber search. |
CSCuq06441 | 3 | After network disconnect and end call, presence return to Available instead of Custom Available. |
CSCuq16548 | 3 | Jabber Edge XMPP reconnect timer too long when VCS-c fails over. |
CSCup29889 | 3 | Phone, company and photo intermittently are missing on Windows 8 (Japanese) . |
CSCuq23747 | 3 | Jabber for Windows can't add more than 7 custom contact in one login session. |
CSCuo75418 | 3 | Called party also receives call pickup notification when URI dialled. |
CSCuo88572 | 3 | Show-unavailable not working after joining as hidden. |
CSCuq39413 | 3 | Screen capture corrupted when AES enabled. |
CSCup78097 | 3 | Jabber search on a user is returning multiple Outlook contacts for users. |
CSCuq08775 | 3 | No presence in Outlook after upgrading Jabber with Outlook running. |
Identifier | Severity | Headline |
---|---|---|
CSCun55968 | 2 | Intermittent SSO Login Failure - XML displayed in login window. |
CSCun84531 | 2 | Jabber IMs lost due to interop with Webex Social. |
CSCun84550 | 2 | Jabber IMs lost due to mismatch with Connect Encryption. |
CSCuo58290 | 2 | Jabber for Windows crashes intermittently. |
CSCuo82526 | 2 | MRA Jabber does not send cookie x-auth token with login request. |
CSCup23913 | 2 | Multiple Vulnerabilities in OpenSSL. |
CSCup49887 | 2 | Unexpected behavior in Telephony plugin |
CSCug96646 | 3 | Jabber for Windows Photo Retrieval fails if PC username is non-English. |
CSCuj91246 | 3 | Different IM/Email Ourlook local contacts |
CSCuj93682 | 3 | J4W emoticons are garbled after some UTF-8 Characters. |
CSCum95601 | 3 | Jabber Windows call window becomes active after 15 minutes. |
CSCun70392 | 3 | Unexpected exit while idle over Edge. |
CSCun71221 | 3 | Caller information (ID,Photo) does not update on call toast and window. |
CSCun79048 | 3 | Importing Contact in Jabber Windows Phone-only mode. |
CSCun81773 | 3 | Jabber automatic roll out not possible - missing signature for VBScript. |
CSCun83632 | 3 | Jabber shows groups incorrectly for non-ASCI characters and CUPC. |
CSCun84091 | 3 | Search clearing is inconsistent. |
CSCuo09358 | 3 | Users' self-presence shows offline. |
CSCuo11530 | 3 | Intermittent crash on searching for contacts. |
CSCuo60610 | 3 | Cisco Jabber for Windows does not honor Jabber-config file. |
CSCuo62929 | 3 | Failing to update in-memory dialing rules. |
CSCuo73272 | 3 | Crash in Person Manager. |
CSCuo83479 | 3 | Can't view contact's profile although permission is on. |
CSCuo90291 | 3 | Jabber screen sharing quality varies due to cached low bandwidth level. |
CSCuo95351 | 3 | Presence shows offline while chatting with user on my contact list. |
CSCuo98047 | 3 | Need UDS details of how to configure Jabber for Expressway MRA. |
CSCup02217 | 3 | J4W: Quality of screen sharing degrades upon offered max-fs by Windows. |
CSCup14715 | 3 | Private number is not stored in call history of Jabber for Windows. |
CSCup16016 | 3 | Contact Name becomes IM address after reboot. |
CSCup28751 | 3 | Czech characters in name not displayed correctly when used through UDS. |
CSCup39611 | 3 | Jabber requires Voicemail server config on IMP. |
CSCup45076 | 3 | Jabber Windows exits unexpectedly immediately after login while parsing VCard. |
CSCup54435 | 3 | Enabling VVM in OrgAdmin, enables it for all users. |
CSCup70296 | 3 | Jabber incorrectly modifying nickname field. |
CSCup82773 | 3 | Call drops after a temporary network loss. |
CSCup84971 | 3 | AllowUserCustomTabs=false doesn't work if you have a custom tab created. |
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The following documents are available for Cisco Jabber for Windows.
Installation and Configuration Guide
The Installation and Configuration Guide provides administrators with information on software, hardware, system, and network requirements; deployment planning; installation; and client configuration.
Server Setup Guide
The Server Setup Guide provides administrators with task-based information to help configure client services such as directory integration, instant messaging and presence, audio and video calling, voicemail, and conferencing.
DNS SRV Configuration Guide
Automatically discover on-premises servers inside the corporate network.
Determine whether the client is inside or outside the corporate network.
Licensing Information
This Licensing Information document provides information on the open source libraries used by the application.
Quick Start Guide
Instructions to help navigate end users around Cisco Jabber for Windows for the first time and use a few key features.
Advanced Features Guide
The Advanced Features Guide provides an overview of task-based information about end user operation of the client.